Automating Firm Workflows in Time Matters®

Presented by:
Attorney Jeffrey S. Krause
Krause Practice Management, LLC
Lawtopia, LLC
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>Customizing the Time Matters Interface</td>
<td>3</td>
</tr>
<tr>
<td>Customizing Toolbars</td>
<td>3</td>
</tr>
<tr>
<td>Customizing the List Display</td>
<td>4</td>
</tr>
<tr>
<td>Edit Columns</td>
<td>4</td>
</tr>
<tr>
<td>Time Matters Quick Tabs</td>
<td>4</td>
</tr>
<tr>
<td>Quick Tabs</td>
<td>4</td>
</tr>
<tr>
<td>Quick Tab Setup Dialogs</td>
<td>5</td>
</tr>
<tr>
<td>General Tab</td>
<td>5</td>
</tr>
<tr>
<td>Name</td>
<td>5</td>
</tr>
<tr>
<td>Show on Main List Tabs</td>
<td>5</td>
</tr>
<tr>
<td>Show on Menu</td>
<td>5</td>
</tr>
<tr>
<td>Show Power View</td>
<td>5</td>
</tr>
<tr>
<td>Vertical Grid Lines/Horizontal Grid Lines</td>
<td>6</td>
</tr>
<tr>
<td>Show Code Description</td>
<td>6</td>
</tr>
<tr>
<td>Show Staff Name</td>
<td>6</td>
</tr>
<tr>
<td>Show Color Lines</td>
<td>6</td>
</tr>
<tr>
<td>Customize List Font</td>
<td>6</td>
</tr>
<tr>
<td>Fields Tab</td>
<td>6</td>
</tr>
<tr>
<td>Filter and Sort Tab</td>
<td>7</td>
</tr>
<tr>
<td>Reports from Quick Tabs</td>
<td>8</td>
</tr>
<tr>
<td>Outlines and Chains</td>
<td>8</td>
</tr>
<tr>
<td>Outline</td>
<td>8</td>
</tr>
<tr>
<td>Outline Controls</td>
<td>8</td>
</tr>
<tr>
<td>Using Outlines</td>
<td>8</td>
</tr>
<tr>
<td>Chain Templates</td>
<td>11</td>
</tr>
<tr>
<td>Using Chain Templates</td>
<td>12</td>
</tr>
<tr>
<td>AutoEntry Forms and Triggers</td>
<td>14</td>
</tr>
<tr>
<td>AutoEntry Forms</td>
<td>14</td>
</tr>
<tr>
<td>Creating an AutoEntry Form</td>
<td>14</td>
</tr>
<tr>
<td>Using an AutoEntry Form</td>
<td>16</td>
</tr>
<tr>
<td>Triggers</td>
<td>17</td>
</tr>
<tr>
<td>Creating a Trigger</td>
<td>17</td>
</tr>
<tr>
<td>Trigger Actions</td>
<td>18</td>
</tr>
<tr>
<td>Using a Trigger</td>
<td>19</td>
</tr>
<tr>
<td>Automating Common Tasks</td>
<td>19</td>
</tr>
<tr>
<td>Create an AutoEntry Form</td>
<td>19</td>
</tr>
<tr>
<td>Create a Trigger</td>
<td>21</td>
</tr>
<tr>
<td>About the Presenter</td>
<td>23</td>
</tr>
</tbody>
</table>
Introduction

Time Matters offers many ways to customize the workflow in your office. This session will start by introducing you to a few simple customization features. These customizations can make your use of Time Matters much more productive. In addition, you will learn how some of the more advanced features of Time Matters. Using Quick Tabs, Outlines, Chain Templates, AutoEntry Forms and Triggers, you can take your use of Time Matters to a new level.

Customizing the Time Matters Interface

Customizing Toolbars

Time Matters 7 added multiple toolbar functionality. This was very useful in that it allowed you to create secondary toolbars that included groups of functions. For example, many of our clients created separate toolbars for Billing Matters icons as well as to make it easier to add records.

Time Matters 9 extended the multiple toolbar concept by allowing multiple toolbars to be displayed at the same time. In versions 7 and 8, this was not possible.

Selective Text on Right is a new function that displays a thinner toolbar with button text to the right rather than below the icon. This can be very useful when a user desires to free up vertical space in their time matters display.

Several buttons have also changed on the Time Matters 9 toolbar. While the Daily, Weekly, Monthly and Scheduler buttons are still available, it is now possible to consolidate all of those under a single Calendar icon. Many of our clients were already doing this by eliminating the three or four calendar icons that they did not open on a routine basis. The new calendar icon includes a pull down arrow allowing the user to choose which calendar to open. It also defaults to the last selected calendar view.

It should also be noted that several of the shipping default toolbar icons changed in Time Matters 9. Users who upgrade will not notice any difference. However, if you add new users they will acquire the new default toolbar icons. The new defaults do not include Events or ToDos but do include Docs, Matter Journal, Navigator as well as the new Calendar icon.

Finally, several new icons are available for the toolbar. Users can add a Search All Records icon as well as icons for the new User Definable Records. Both of these topics will be covered in more detail below.
Customizing the List Display

Edit Columns

Users may also edit the List Display for most Time Matters lists. When a list is opened, it may be edited by selecting the Edit Menu and Columns or by right clicking on any Quick Tab and selecting Edit Columns.

The Edit “List Name” List Fields dialog allows users to add fields to the list column display and change the order of the columns. On the left is a list of all Available Fields and on the right is a list of all fields currently “In List.”

Add fields to the list by double clicking it on the left. Remove fields by double clicking on the right. Alternatively, a field may be highlighted and Add or Remove selected. Moving a column to the left or right is accomplished by highlighting it in the “In List” selector and clicking Up or Down.

Time Matters Quick Tabs

Quick Tabs

Quick Tabs are preset filters that can contain a specified search and list display. Quick Tabs are a great way to quickly recall frequently viewed information. Quick Tabs setup is accessed via the Edit Menu, Quick Tabs selection. It can also be accessed by right clicking on any Quick Tab and selecting Edit Quick Tabs. Finally, they can be accessed via the Options button on any list.
Quick Tabs may be User Level or Program Level. Quick Tabs created from the access methods discussed above will be User Level. Unless they are copied to another user, User Level Quick Tabs are available only to the user who created them.

Program Level Quick Tabs are available to all users. They can only be created by users with appropriate security settings. For those with the ability to create them, Program Level Quick Tabs are created via the File Menu – Setup, General, Program Level, Lists.

Quick Tab Setup Dialogs

General Tab

Name

Use this field to describe the Quick Tab. This field is only used for identification purposes on the Quick Tab list.

Show on Main List Tabs

If this checkbox is checked, the Quick Tab will be displayed along the top of a Record List resembling a file folder tab. The text entered in the Name field to the right of the checkbox is the name that appears on the tab. In version 9, Quick Tabs are not displayed on the Main List by default. They must be enabled.

Show on Menu

If this checkbox is checked, the Quick Tab will be accessible from the program Main Menu. The text entered in the Name field to the right of the checkbox is the name that appears on the menu.

Show Power View
Shows information from the highlighted record in the Power View pane. Select the required Power View from the drop down menu.

### Vertical Grid Lines/Horizontal Grid Lines
Set gridlines to show on the list.

### Show Code Description
Show the description of the Classification Code when Code is on the list of fields to show.

### Show Staff Name
Show the name of the staff member instead of initials when Staff is on the list of fields to show.

### Show Color Lines
Alternating lines will appear in a different color. Set the color using the Color button.

### Customize List Font
Set the font to use for the displayed list.

### Fields Tab
Specify which fields will be displayed on the list when this Quick Tab is selected. Move fields from the Available list to In List and use the Up and Down buttons to arrange the order.
Filter and Sort Tab

Set Record Filter allows you to apply a filter that determines which records will be displayed on the list when this Quick Tab is selected. Available filters are Saved Searches, Combined Filters and Advanced Filters. The ability to Use Saved Tags was added in version 9. It allows you to use a list of previously searched and tagged records as the basis for your quick tab.

Record Sort determines the sort order of the records that appear on the list.
Reports from Quick Tabs

Quick Tabs are also one of the fastest and easiest ways to produce reports from Time Matters. Quick Tabs contain a pre-designated search, sort and list layout. Therefore, most of the work necessary to run a report has already been accomplished by the time the Quick Tab has been executed.

Because a Quick Tab can contain a list layout, a List Format Custom Report run from it will contain the list columns in the same order and sort defined by the Quick Tab.

Another way to create a report from a Quick Tab is Send to Excel. The resulting spreadsheet will contain the Quick Tab's search, sort and column layout.

Outlines and Chains

Outline

Outlines were introduced in Time Matters 6.0. Outline Records are organized lists of information that can be used in a number of ways. Individual elements of Outlines can be associated with new or existing Time Matters records to create a link between the element and that record. This allows easy access to the associated record from the Outline as well as ability to mark records done, directly from the Outline.

Outline Controls

Outlines are controlled through the Outline Toolbar, which provides the following functions:

Split Screen for History/Memo - Displays the Memo field, which is hidden by default on an Outline.

Add/Change/Delete Element - Allows the addition or modification of elements in the Outline.

Associate Element - The pull down menu at the right of this icon allows the highlighted Outline element to be associated with another Time Matters record.

Open Associated Record - Opens the Time Matters records associated with the highlighted Outline element.

Move Element Down/Up - Moves the highlighted Outline element up or down in the Outline.

Demote/Promote Element - Demotes (moves to the right) or Promotes (moves to the right) the highlighted Outline element to a different level.

Expand/Collapse Level - Expands an Outline element so that all levels of that element below it are visible or collapses it so that only the top level is visible.

View Level (1-5, A) - Shows Outline levels up to and including the level selected. The default is to show all levels.

Process - There are three processes specific to Outlines. Create Records creates associated records from the Outline, Mark Done will mark all selected elements Done and Remove Associations will unlink the select Outline elements from any associated records.

Send to Word - Sends the formatted Outline to Microsoft Word.

Print - Sends the Outline to a Print or Print Preview.

Using Outlines
One way to use Outlines is to organize thoughts into an ordered list. An example of this type of Outline is one in which the questions to be asked of a particular witness are listed and broken down into their component parts.

Another type of Outline is one that contains a list of items and tasks related to a Matter. This type of Outline is valuable when you have an extensive series of tasks to perform for a Matter, and you do not want to create individual To Dos for each task. A task based Outline is a powerful tool and allows you to use many of the additional features built into Outlines.
Right-clicking on an element in an Outline provides many of the same functions found on the Outline Toolbar.

While many of the right click functions are replicated from the Outline toolbar, there are several that are unique to the right click. These include the ability to "Mark Done" an Outline element or to "Mark Not Done" the same element. This makes it possible to visually identify the items in the task list that have been completed. (Note: Currently, strike-through will not appear on a printout of an Outline.)
Chain Templates

In many areas of the law, things happen according to a specific sequence of events. Often, the timing of events and deadlines are set by statute. Chain Templates allow Time Matters users to create specific “chains of events” to implement rules-based scheduling.

Chain Templates are accessed by selecting the File Menu, General, Setup, Templates, Chain Templates. Add a new chain and provide a name when prompted. The next dialog allows items within the chain to be created.

Click Add to create an item. Items may be any of the main and supporting record types other than Contacts or Matters. Select a name for the item and the type of record. Once these are selected, a form for the record type will appear.

Information entered on the record form will appear each time the Chain Template is run. For this reason, it is important to enter only information that is generic to each Matter. For example, it would be advisable to enter “Answer Complaint” in the Description field for an item but not advisable to enter “File Answer with Judge Smith.” This is because the presiding judge will likely change for each Matter.

The most important part of the form is the Date Selector. This allows one record to be sequenced a number of days before or after another using the Date Calculator. Many settings can be used to modify the Date Calculation, as shown on the graphic below.
Remember to add appropriate Reminders to the record if you want to be reminded of the item before the scheduled date. Do not enter information in the Regarding fields concerning Client and Matter. You will be prompted for this information each time you use the Chain Template.

As you create items, your Chain Template will display and show you the relationship between the records. When all items have been entered click Close.

**Using Chain Templates**

Chain Templates are used by selecting the Calendar Menu and Schedule Chains. Your previously created Schedule Chains will appear. There is a difference between Chain Templates and Schedule Chains. Chain Templates are the templates themselves and may be used over and over, while Schedule Chains are instances where you have used a Chain Template. Schedule Chains are usually unique to a single Matter.
When you create a new Schedule Chain, you are prompted to enter a name for the Chain, a Base Date and the case to which it relates. The Base Date is day “0” of the chain from which all other dates are calculated. The Contact, Matter and Staff information entered on this screen will complete the Regarding and Staff fields on the chained records.

There are two boxes on this screen that require explanation. “Items created will be linked together” links the records in such a way that changing or deleting one will cause a prompt asking you whether you want to update all subsequent items in the chain. In recent versions of Time Matters, this box is checked by default. “Create an Outline Record for this Chain” was added in Time Matters version 7. This box creates a single, easily accessible list of all items in the chain as well as easy access to those items. See Outline for more information on using Outlines as checklists.

After this information is entered, click OK to preview the Chain. The Chain Preview will show the various individual records to be created as well as the day on which they will be scheduled. Click Create to generate the records.

Records in a Schedule Chain act like any other records. They will display on calendars, power views and reports. In addition, Time Matters remembers the links between records. This means that if an item in a chain is rescheduled, Time Matters will prompt the user whether any dependent records should be adjusted according as a result of the changed item.
If you selected "Create an Outline Record for this Chain," you can view the Outline by opening the Matter, clicking the Outline tab and opening the Outline.

AutoEntry Forms and Triggers

AutoEntry Forms
AutoEntry Forms are one of the many automation features included with Time Matters. AutoEntry forms are templates for Time Matters records. Data entered into an AutoEntry Form can be saved and used in subsequent records. This can save time and avoid data entry errors. AutoEntry Forms can be created for any Time Matters record.

Creating an AutoEntry Form

AutoEntry Forms are created from the File Menu, Setup, Templates, AutoEntry Form selection. Select Program if you wish the AutoEntry Form to be available to all Time Matters users or User if it will specific to the logged in user. Select a Time Matters record type by clicking the appropriate tab, then adding an AutoEntry Form with the green plus symbol. If you are creating large numbers of AutoEntry Forms, they can be organized into folders. This is done by clicking the folders icon on the toolbar. It is also possible to copy an existing AutoEntry Form and use it as the template for another.
Enter a description for the AutoEntry Form. This is the name that will appear in any list where AutoEntry Forms can be selected. Next, complete the AutoEntry Form by filling all fields that will be common to subsequent records. Do not enter information that will be different each time the record is used. For example, "Meeting with" is appropriate in the Description field but you should not enter "Meeting with Mr. Jones" as the person being met with changes from meeting to meeting. This, of course, assumes that you are not creating an AutoEntry form for a meeting with Mr. Jones. Similarly, do not complete the Client or MatterRef fields unless you are creating an AutoEntry form for use with a single Client or Matter.
When all necessary fields are completed, click Save and Close to complete the AutoEntry Form.

**Using an AutoEntry Form**

The toolbars for all Time Matters records include a button that allows an AutoEntry Form to be selected. A click on this button will produce a list of all available AutoEntry forms for that record type. Selecting a form will complete the new record with the fields from the AutoEntry Form.

Alternatively, the right edge of this button provides a second choice that allows the current record to be saved as an AutoEntry Form. When using this feature, remember to clear any fields where the data will vary from record to record.

For information on other ways to use your AutoEntry Forms, see the section on Automating Common Tasks.
Triggers
A Trigger is a Time Matters automation feature that causes something to occur based on another action. For example, a Trigger can cause a new record to be created when another is marked "Done" or cause a TM Message to be sent when a record is deleted.

Creating a Trigger

Triggers are created from the File Menu, Setup, Template, Trigger selection. Select the record type from which the Trigger will fire, not the type of record that will be created.

To create a Trigger, you must tell Time Matters what action causes the Trigger to fire and what should happen when it does fire. Triggers can fire when a record is added, changed, archived or deleted. They can also fire when a field is changed or changed to a specific value.

Triggers can fire for all records of a given type or only when specific criteria are met. For example, a Trigger can be limited to fire when the Code, Staff, Contact, Matter or User are a specific value. These options are set under the Scope section of the Trigger setup.

The Active section of the Trigger setup specifies when the Trigger can be fired. Always means that the Trigger will always fire when the criteria are met. Based on Trigger Checkbox means that the Trigger will fire when Trigger is checked. Finally, User Activated from Record means that the Trigger will fire when the user chooses to fire it from a Trigger List. The User Activated from Record selection is extremely useful when creating a list of automation features like the IP Associates QuickFlow system.
Trigger Actions

A Trigger Action is what occurs when the criteria for the Trigger is met. Actions are added from the Actions section of the Trigger setup screen. There are a number of Actions that can take place.

Add New Record. This action adds a record of the type designated in the Record to Add selection. Designate an AutoEntry Form, if desired.

Archive Record. This action archives the record from which the Trigger fired.
Change Field.  This action changes the field designated in the Change Field selection.

Create Chain.  This action creates the Chain Template designated in the Chain to Create selection.

Send Message.  This action sends a TM Message to the User designated in the Msg to User selection. The Message Text field determines the text of the message.

Launch Program.  This action launches a program. The path to the program executable or extension must be designated in the Command selection.

**Using a Trigger**

To use a Trigger, make sure that the appropriate criteria are met or check the Trigger checkbox on a record. A list of the Triggers meeting the criteria will appear, allowing you to select the Trigger.

To fire a "User Activated" Trigger, highlight a record in the appropriate list and click the Trigger icon on the list toolbar. A list of all Triggers for that record type will appear allowing you to select the Trigger you would like to fire.

**Automating Common Tasks**

Two of Time Matters advanced functions can be combined to automate common activities.

**Create an AutoEntry Form**

The first step in automating tasks is to create an AutoEntry Form for the record that is commonly created. The AutoEntry Form will populate as many fields as possible on the record after you select it from the list. Typically, fields that are automatically populated include the Code, Description, and user-defined fields. In the example below, a To Do AutoEntry Form that creates a Delegated ToDo is shown.
<table>
<thead>
<tr>
<th>Description</th>
<th>Delegated ToDo</th>
</tr>
</thead>
<tbody>
<tr>
<td>8/15/2007</td>
<td></td>
</tr>
</tbody>
</table>

**Memo/Instructions:**

- Delegated By: [Empty]
- Current Status: Not Started
- Details: [Empty]
- Assigned To: [Empty]
- Completed: 8/15/2007
- Case Details: [Empty]
- Judge: [Empty]
- Case #: [Empty]
Create a Trigger

The next step is to create a Trigger. Once created, the Trigger can be "fired" to create the record defined by the AutoEntry Form. A classic way to create a Trigger is to fire it when a specific field is changed to a specific value. The example below is from the IP Associates QuickFlow System. As you can see, the Trigger fires when the field "Common" on the Domestic Matter form is changed to a value "Delegate a ToDo.”

Alternatively, the trigger can be set to fire when the user activates it from the record. This means that the trigger can be fired when desired by the user. The Trigger below is set to fire as "User Activated from the Record" (basically, when and only when the user says) on the Matter List.
Click Add to designate the actions that will take place when the Trigger fires. In our example, the specific settings on our Trigger tell Time Matters to add a To Do based on the AutoEntry Form we created earlier.

There are several ways that the common activity can be told to fire. In our QuickFlow system, fields on the Matter form contain lists of common activities based on the type of Matter. These drop down lists provide choices to allow the fast creation of items.
Alternatively, you could add the Trigger button to the Matter List toolbar. Selecting the Trigger button will display a list of possible Triggers. Organize your different items into related lists and you have what has been called an "Action List."

### About the Presenter

Jeffrey S. Krause is a Wisconsin attorney and is the owner and founder of Krause Practice Management, LLC. Krause Practice Management provides technology advice and service to law firms of all sizes, with a focus on the efficient use of technology in the law office.

After beginning his career in private practice, Mr. Krause began assisting other attorneys to better use technology in their law practice. Since 1998, he has assisted hundreds of law firms through custom configurations, training and general support.
Mr. Krause is a Certified Independent Consultant (CIC) for the popular Time Matters Business and Practice Management software as well as its companion, Billing Matters. He has worked with Time Matters through its last nine versions and has assisted hundreds of law firms during his twelve years as a CIC. He is also a CIC for LexisNexis PCLaw and is certified or authorized in dozens of other law office applications.

Mr. Krause is a frequent author and speaker on a variety of legal technology topics and is the primary contributor to Jeff Krause's Practice Management Blog. His extensive background includes knowledge of document management, e-mail systems, litigation support, time and billing, web marketing and office suite applications. In 2006, he teamed up with Neil Johnson of Practice Development Partners and created the nationally recognized Time Matters Boot Camp training seminar. Time Matters Boot Camps are now routinely held at cities around the country.

Prior to embarking on his career as a Technology Professional, Mr. Krause was engaged in the private practice of law. His legal background includes Plaintiff's Personal Injury, Insurance Defense, Real Estate, Land Use Planning and Corporate Law. Jeff is a 1996 graduate of the Marquette University Law School. He also holds a B.A. and M.A. in History from the University of Wisconsin-Milwaukee.

In 2010, Mr. Krause became one of the founding members of Lawtopia, LLC. Lawtopia is a partnership of nine of the most successful legal technology consultants in the nation.

Jeffrey S. Krause
Krause Practice Management, LLC, 5002 Mesa Court, Waterford, WI 53185 262-806-7218
Web: http://www.krausepm.com  Blog: http://www.krausepm.com/blog  Email: jeff@krausepm.com